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1 Introduction  
 
Welcome to TOXICALL®! Thank you for choosing the number one poison 
control center database software in the United States.  We want your 
experience using TOXICALL® to be the best it can be, so we have created this 
manual for your use. We appreciate and encourage your comments and 
suggestions, both on our software as well as on this manual.  

This manual is divided into three parts.  The first part focuses on Getting Started 
in TOXICALL®. The second book is built around Searching Techniques and the 
last book deals with Troubleshooting. Our hope is that these documents will help 
you learn to use TOXICALL® in the most efficient manner possible, thus freeing 
you to do your important work:  patient care.  

Sincerely,  

The TOXICALL® Team 
 
 
 

1.1 TOXICALL® Features 
 

• Ability to queue batches of reports to be emailed, printed, or saved to file 
• Ability to encrypt files being sent via Batch Queue 
• Ability to create custom displays 

• With Microsoft Excel loaded on the PC, the ability to export data to a 
graph format 

• Ability to create User Created Fields (UCF) to collect custom data not 
currently being collected by TOXICALL® 

• Ability to create User Created Requirements (UCR) to customize what 
data is required in a case 

• Ability to Create Custom Labs to collect lab data within a case 

• Ability to create Continuous Quality Improvement (CQI) tests for Quality 
Assurance 
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• Integration with two Call Recording Systems (Higher Ground and 
Mercom), allowing you to associate call recordings with cases and listen to 
calls from within TOXICALL® 

• Multiple Document Interface (MDI) Display - TOXICALL® has the ability to 
display multiple cases simultaneously 

• Can specify a follow-up date and time and see it in default search display  
• Ability to customize searches and save the criteria for later use 
• Cases can be prioritized as Low, Medium and High 
• AAPCC Reports included and ready to use 
• Ability to upload cases real-time to AAPCC (Autoupload) 
• Ability to setup predefined information that can be entered into the Notes 

section with the click of a button (Keycuts) 
• Ability to upload to the network database immediately upon saving the 

case 
• Windows are resizable and moveable, or can be set to maintain size and 

position 
• Zip Code / Area Code lookup queries – performing a lookup will insert 

area code, city, state, zip and county in appropriate fields 
• QA function allows notes to be entered on each case in a special QA field 
• Many customizable fields and dropdowns 
• Ability to output reports in different formats such as Adobe Acrobat (.pdf) 

or Microsoft Excel (.xls) 
• Users can continue entering cases on their local database in the event of 

a network failure 
• ‘Save’ allows the entry of follow-up times for cases stored on the local or 

network database 
• View / Summary Window has the ability to turn on and off, resize or place 

a case anywhere on the screen 
• The toolbar can be turned on or off by selecting View / and check Toolbar 

to display or hide 
• Templates can be created from a current case and applied to a new case, 

and can be created on all fields, including open SPI Notes 
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2 Overview of TOXICALL® 

TOXICALL® is a poison control center call database software that is designed 
to make case entry, tracking and reporting easy, yet flexible.  
 
TOXICALL® uses four databases:  ToxiSys, ToxiUser, ToxiNet and ToxiLoc. 
The ToxiSys database holds information about your system tables that 
contain information maintained only by TOXICALL®. The ToxiUser holds 
information about your system tables that can be modified by users. The 
ToxiNet is your network database and is connected to by all users on your 
system to maintain a central repository of cases.  The ToxiLoc is the local 
database.  The local database is used for adding, modifying and reviewing 
cases. When a case is opened on the local database, it will show as locked 
on the network database so that other users cannot attempt to make changes 
to a case that someone else is modifying, thus ensuring data integrity.  
 
The ToxiSys and ToxiLoc databases will always be Access97 or Access2000 
(see later discussion on the differences between these versions). The ToxiUser 
and Toxinet databases can be Access97, Access2000, SQL Server 7, SQL 
Server 2000, or SQL Server 2005.  For more information on the features of 
these database types, please visit Microsoft’s website at www.microsoft.com.  
 
Three other files of importance are the toxicall.ini, autoupload.ini and 
TX000nnn.ini (where nnn represents your three digit center code). The 
toxicall.ini file holds the specific configuration information for that particular 
machine.  The options for this file will be discussed in more detail later in this 
manual.  The autoupload.ini file will be located on your machine that has 
Autoupload installed. This file sets up Autoupload and defines its connection 
information, including your center’s login and password for scanning out cases 
to the AAPCC, and which database it should search for unscanned cases. This 
file will be discussed more in the Scanning Out/Scanning In chapter later in this 
manual. The TX000nnn.ini file is the license file.  On the server (wherever you 
have located your Toxinet.mdb, or Toxisys.mdb if you are running SQL), this file 
contains all the license codes and keys for your site.  This is the file that you will 
send to TOXICALL® Technical Support when you need to update your licenses.   

When you update custom information for any of the dropdowns, such as the SPI 
List or the Health Care Facilities List, you are making this change through a 
system table. Most system tables allow custom entries. System tables will be 
discussed in further detail in the System Tables chapter in this manual. 
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3 TOXICALL® Configuration Window 

The Configuration window sets up the specifics of your TOXICALL®, such 
as the location of your databases, your center’s name and number, and 
text attributes that can be used for the Case Notes. Only those users with 
supervisor rights will have access to the Configuration window.  The 
Configuration window can be reached by going to the Tools menu, and 
selecting Configuration.  
Note: To see the Tools menu, you must close all cases and search 
windows.  
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The Configuration window changes both local and global settings for 
TOXICALL®. The local settings are found in the Workstation Configuration 
section of the Configuration window and are workstation specific. They will only 
be applied to the workstation on which the changes are being made or displayed. 
The License button is also a local setting and will only update the license for that 
machine when in that window.  The More button, which opens the More window, 
also contains local settings.  
 
The global settings are in the TOXICALL® System Configuration section.  If 
an item in the TOXICALL® System Configuration is changed it will affect all 
workstations using the same TOXICALL® network database (usually all of 
your users).  
 
Below, we will discuss each option in the Configuration window. 
 
 

3.1 Workstation Configuration Section 
 

 
 
 

3.1.1 Access Version 

The Access version drop down allows the selection of which driver TOXICALL® 
will use to connect to the databases. In the example above, Access 97 (Jet 3.51), 
the recommended driver, has been selected. The Jet 3.51 driver is considerably 
quicker when accessing the data in the files, and is the most compatible driver for 
TOXICALL®.  
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Note: Access 2000 (Jet 4) is a driver option that is available for selection. 
However, when selecting the Jet 4 driver it is necessary that both your network 
database and local database be Access 2000 format databases for TOXICALL® 
to function properly.  Before choosing to set your databases as Access2000 type, 
it is important to understand: 
 

• It is not possible to view Access 2000 databases using Microsoft Office 97 
• The drivers required to use this option are shipped with TOXICALL®. 

However, if your site has not installed Office 97 or 2000, it will not be 
possible to view raw data tables via Access 

• If you have decided to use the Access 2000 database type, and later 
decide to try the Access 97 driver, it will be necessary to recreate both the 
local and network database and migrate the data into the new structures 

• Jet 4.0 driver is touted as being more robust by Microsoft. However, for 
TOXICALL®’s  purposes the extra frills are not necessary and result in 
decreased performance 

• Once it has been determined which driver will be used, it is critical that all 
databases are created with the same driver, thus avoiding error messages 
and functionality issues 

 
 

3.1.2 Upload Interval and Network Check 

These two options should both be set to zero. They are currently disabled, but 
are reserved for future use. 
 
 

3.1.3 Network Location and Local Database 

TOXICALL® uses two databases to work with cases; the network database and 
the local database. The network file usually resides on the server in a shared 
folder so all cases can be seen by all users. Cases currently being worked on will 
be stored on the local drive of the computer on which they were created, but will 
show on the network database as Locked. If you are running your network 
database on Access, it will resemble the first graphic. If you are running on SQL, 
it will look like the second graphic below (notice the Network location line has 
changed). 
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The Network Location line in the Access graphic above shows that the network 
database path is d:\toxinet\. The actual filename of the network database is 
Toxinet.mdb, TOXICALL®’s recommended file name for an Access network 
database.  In the SQL graphic, the network location is pointed to the SQL server 
using a Provider, Data Source, User and Password.  The SQL graphic also 
differs in that it shows the location of the System database (ToxiSys.mdb).  Since 
it is not stored in the same directory as the network database in SQL 
installations, it must be given its own pointer line.  For more information on SQL 
installations and setup, please contact TOXICALL® Technical Support for our 
SQL Server Data Migration Guide.  

Note: The ToxiSys can be stored anywhere on your network. However, it is 
critical that the TX000nnn.ini file be stored in the same directory.  All client 
machines need to be pointed at the same Toxisys.mdb file.  
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The local database line defines the location of the local database, usually on the 
same workstation. The mapped path above shows its location as C:\Program 
Files\cas\toxicall. ToxiLoc.mdb is the recommended file name for the local 
database. 
 
For configuration purposes, the setup of the local and network 
databases is the same 
 

• To update the network or local database location, click the Lookup button 
 

• The next panel will ask you to specify the Database Type as either Access 
or SQL.  If you are setting up a SQL database, please refer to the SQL 
Installation guide for TOXICALL®. If you are setting up an Access 
database, click the lookup button next to the Database Location line. This 
will take you to a browsing window 

• From here, using the dropdown menu and navigating through the files, 
you will choose the directory where this file is to be located. When you 
have set the location and made sure your filename will be unique, so as to 
not write over existing important data, click Save. This will take you back 
to the previous window, click OK 

• If this is a new database you will get a message stating that the file does 
not exist and asking if you would like to create it, click Yes.  This will take 
you back to the main Configuration window, click Save again 

• The system will pop up a message that TOXICALL® will now exit and 
needs to be restarted, click OK. TOXICALL® will release some tables and 
then close.  When you reopen TOXICALL® it will function with the 
new/modified database 

 
Note: By allowing users to work on their local database until connectivity is 
restored, TOXICALL® can continue to capture cases during a network failure. 
 

 -- Compact/Repair: This will run a Compact and Repair on the respective 
database (one icon is next to network and the other is next to local 
database). 

 -- CopyToxiUser information to SQL: This is automates the process of 
copying system table information when switching from an Access 
database type to a SQL Server database type.  Note:  Be sure you back 
up your ToxiUser before performing this process.  This configuration can 
cause the loss of the source database file data.  

 
 

3.1.4 Required Fields Color 

This option allows a Supervisor to specify the color of fields that must be filled in 
before a case can be closed. Fields that are required will show as the color 
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assigned to Required Fields until the field is filled.  It is possible to save a case 
with a status of ‘Open’ without all required data fields having been completed, 
however, before allowing the case to be closed all required fields will have to be 
filled.  

Note: Having required fields in TOXICALL® can help you record additional 
information on your cases that is not required by the AAPCC.  For example, you 
may wish to capture ‘Caller Title’ on all cases your center takes, which is not 
required by AAPCC.  By adding color to the field, you are giving a visual prompt 
to your SPI’s, making them aware that ‘Caller Title’ is a required field. 
 
 

3.1.5 Save and Cancel Buttons 

These buttons are found on the upper right hand side of the Configuration 
window.  To save changes to the Configuration window, click Save. To cancel 
changes to the Configuration window, click Cancel. 
 
 

3.2 TOXICALL® System Configuration 

 
 

Global options, located in the lower portion of the configuration window, affect all 
workstations configured to use the same network database. 
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3.2.1 Center Code 

Enter the numeric code given to your center by the AAPCC in the Center Code 
field. The center code will be displayed on reports you generate in TOXICALL®. 
It is also used to code your data sent to the AAPCC, thus it is important that this 
is correct. 
 
 

3.2.2 Language 

Set this to the desired language for your Poison Control Center 
 
 

3.2.3 Center Name 

Enter the official name of your center in the Center Name field. The center name 
will be displayed on reports you generate in TOXICALL®. 
 
 

3.2.4 Location Code Type 

Allows the site to collect data by either Caller Zip Code or Caller Area Code 
Exchange.  Set this appropriately for your center.  

Note: When upgrading from older versions of TOXICALL®, the Location Code 
type must be set prior to migrating any data. The data migration routine checks 
this setting and then moves the data into the appropriate fields based on your 
selection.  

Example: If calls have been recorded using Area Code exchange in 
TOXICALL®3.6 or 4.0, make sure Location Code type is set to Area Code 
Exchange prior to migrating data, even if your center has decided to change 
location code type to zip codes. Once migration is complete, the location code 
type can be changed to zip codes, and moving forward cases will be captured 
based on zip codes and historical data will be preserved. 
 
 

3.2.5 Default State 

This setting will enter the state’s code automatically whenever a new case is 
started. This is handy if you generally only take calls from one state.  

If you get a call from another state, you can type the state code over the default 
that is entered in the address field.  
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3.2.6 Notes Field 

These options are global Yes/No dropdowns and allow the user to choose 
whether or not SPI’s can use the special attributes available in the Note section.  
The options available are: Allow Color Text in Notes and Allow Attributes in 
Notes.  Allow Strikethrough in Notes is currently disabled.  Allow Color Text 
allows the user to use color in their Notes field. Allow Attributes in Notes allows 
the user to use text enhancements such as bold, underline and italic in the Notes 
field. 
 
 

3.2.7 Reset Scanout Flags on Case Save 

Setting this to “Reset” will cause the scanout Flag to be reset when you save a 
case, thus causing the case to be resent to the designated destination via your 
autoupload process. 
 
Setting this to “Not Reset” means that the case will never be resent to the 
destination even if the case has changed. 
 
 

3.2.8 More System Configuration Button 
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3.2.8.1 Enable UCR 
Setting this to yes enables you to set up User Configurable Requirements for 
your Poison Control Center. 
 
 

3.2.8.2 Enable UCF 
Setting this to yes enables you to set up User Configurable Fields for your Poison 
Control Center. 
 
 

3.2.8.3 Enable FIFRA 
Setting this to yes enables the FIFRA module for your Poison Control Center. 
 
 

3.2.8.4 Enable Lab 
Setting this to yes enables the Lab module for your Poison Control Center. 
 
 

3.2.8.5 Enable CQI 
Setting this to yes enables the CQI module for your Poison Control Center. 
 
 
 

3.2.8.6 Enable Graphing 
Setting this to yes enables the Graphing module for your Poison Control Center. 
 
 
 

3.2.8.7 Email Settings 
If you wish to use Batch Queue functionality to send Email messages, you will 
need to configure the Email settings here. 
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3.2.8.8 Network WAN Settings 
These settings are used primarily by centers that share Network databases.  
These settings are designed to ensure that case data is not accidently 
overwritten, and to speed up case saves and moves across a WAN environment. 
 
 

3.2.8.9 TESS Validation 
Setting this to yes will cause all cases to be checked to make sure that they meet 
the AAPCC’s case requirements. 
 
 

3.2.8.10 Call Recording 
Setting this to yes will enable you to integrate the Higher Ground or Mercom call 
recording software with TOXICALL®.  To use this feature, please contact 
TOXICALL® support at support@toxicall.com. 
 
 

3.2.8.11 Call Recorder 
These are the configuration settings for the integration of call recording 
functionality within TOXICALL®. 
 

 
3.3 More Window 

The ‘More’ button, on the right side of the Configuration window, allows access 
to additional local configuration options, such as spellchecking the Notes field 
and setting up TOXICALL® to work with Micromedex’s Health Care Series 
(HCS).  Since these are local options, they will only affect the workstation on 
which they are set. This allows for more customization of different workstations.  
Also, after hitting Save at the bottom of the More window, these changes will be 
saved and there is no need to hit Save on the main Configuration window unless 
you have made separate changes there.  
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3.3.1 Auto QuickSave 

Setting this option to ‘Yes’ will cause TOXICALL® to quicksave cases to the local 
database when the user switches to another case that is open on the desktop.  
 
Example: You are working on Case A, and you need to open Case B. If ‘Auto 
QuickSave’ is set to ‘Yes’, TOXICALL® will automatically quicksave Case A 
when Case B is opened. Upon switching back to Case A, Case B will 
automatically be quicksaved. 
 
 

3.3.2 AutoSave Interval 

Instructs TOXICALL® to automatically quicksave a case based on a user defined 
time interval, set in minutes. This is helpful in the event of system or power 
failures since you won’t lose all of your information, just since the last Auto Save.  
Please be aware that setting this limit too low can cause the performance of your 
system to drop significantly. If you find this to be the case, try setting it to a higher 
number.  

Example: When the Auto Save Interval is set to 2, TOXICALL® will automatically 
quicksave the displayed case to the local database every 2 minutes without 
saving the case. 
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3.3.3 Refresh Interval 

Allows users to specify how often (in seconds) TOXICALL® automatically 
refreshes data in the Search window to display the most current search data 
results. (Previous versions of TOXICALL® required the SPI to click a button to 
refresh the Search window.) Unless the machine you are using is very fast and 
has a lot of RAM, it is recommended that Refresh Interval is set to ‘0’ so it will 
never update automatically and a manual refresh is required. (This is 
accomplished when a new search is run.) The lower the number, the more often 
TOXICALL® automatically updates the Search window.  
 
Example:  Entering 2 in the Refresh Interval field would cause TOXICALL® to 
refresh your Search window every 2 seconds. This uses a lot of machine 
resources and can significantly slow down your system, and if the number is too 
small for your system, it may experience lockups. 
 
 

3.3.4 Show Timers 

This option should be set to No. This option is not enabled and is currently 
not supported.  
 
 

3.3.5 Open, Keep Local 

This option allows the user to change the default save location on the Save Case 
window.  If this is set to No, TOXICALL® will default to saving the case as Open 
status to the network. If this is set to Yes, the program will default to saving the 
case as Open status to the local database.  This option does not affect the user’s 
ability to change the status of the case or the database to which it saves upon 
closing; it only changes the default. 
 
 

3.3.6 PEI Vesta 

This option works with Plant Equipment’s Vesta product. If you are not using 
Vesta, set to No. 
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3.3.7 Req. Follow-up Open 

This option can require users to set a follow-up time for Exposure calls that are 
Open status before allowing them to save the case.  If this option is set to No, it 
will not require that the user enter a follow-up time for Open status Exposure 
calls.  
 
 

3.3.8 HCS Type 

This should be set to ‘32 Bit Browser HCS’ if running Volume 100 or greater of 
the Micromedex Health Care Series. 
 
 

3.3.9 HCS Network Path 

HCS Network Path defines for TOXICALL® the pathname for the Health Care 
Series so it can find the appropriate files.   
 
To locate the appropriate path for your HCS: 
 

• Go to the Windows desktop, right click  the Health Care  
Series (HCS) icon and click Properties. 

• Find the Target field and highlight and copy the path. 
• Back in the TOXICALL® More window, paste the path into the Home Path 

field. Then go to the end of the path, and remove all characters to the right 
of HCS32.  Your system may require you to add a ‘\’ at the end of the path 
before recognizing the path. 

 
Example: If the target path is C:\MDXW\HCS32\Browser32\browser32.exe, the 
appropriate path for your TOXICALL® configuration would be C:\MDXW\HCS32. 
 
 

3.3.10 Network Temp Path 

Temp Path tells TOXICALL® where the information being returned from HCS is 
located. Once both the Temp Path and Home Path are set correctly, TOXICALL® 
is ready to receive information from HCS. If you are still having trouble getting the 
data to come across, please see the Troubleshooting section of this manual.  
The easiest way to configure the Temp Path is to search for files and folders 
on your local hard drive.  
 
To set the Temp Path: 

• Locate file called: MDXUSER.INI, open it and locate Temppath= 
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• Highlight and copy everything to the right of Temppath= 
• In TOXICALL®, paste the data into the HCS Temp Path field. 

 
 

3.3.11 HCS Local Path 

HCS Local Path defines for TOXICALL® the pathname for the Health Care 
Series so it can find the appropriate files.   
 
To locate the appropriate path for your HCS: 
 

• Go to the Windows desktop, right click  the Health Care  
Series (HCS) icon and click Properties. 

• Find the Target field and highlight and copy the path. 
• Back in the TOXICALL® More window, paste the path into the Home Path 

field. Then go to the end of the path, and remove all characters to the right 
of HCS32.  Your system may require you to add a ‘\’ at the end of the path 
before recognizing the path. 

 
Example: If the target path is C:\MDXW\HCS32\Browser32\browser32.exe, the 
appropriate path for your TOXICALL® configuration would be C:\MDXW\HCS32. 
 
 

3.3.12 Local Temp Path 

Temp Path tells TOXICALL® where the information being returned from HCS is 
located. Once both the Temp Path and Home Path are set correctly, TOXICALL® 
is ready to receive information from HCS. If you are still having trouble getting the 
data to come across, please see the Troubleshooting section of this manual.  
The easiest way to configure the Temp Path is to search for files and folders 
on your local hard drive.  
 
To set the Temp Path: 

• Locate file called: MDXUSER.INI, open it and locate Temppath= 
• Highlight and copy everything to the right of Temppath= 
• In TOXICALL®, paste the data into the HCS Temp Path field. 

 
 

3.3.13 HCS Update Interval 

HCS Update Interval defines how often (in seconds) TOXICALL® will go out and 
search for information from Health Care Series when performing a lookup.  The 
recommended setting is 2.  This can significantly slow down your system and if 
the number is too small for your system, it may experience lockups. If you 
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experience delays getting HCS information propagated into a TOXICALL® case, 
try higher numbers until you find the number which is right for your system. 
 
 

3.3.14 Path to Case Files 

This setting will allow you to associate files with TOXICALL® cases.  Set this 
path to a network location that all TOXICALL® users have access to, and they 
will be able to associate documents or graphics with a case.  Then, when another 
user accesses the case, they too will have access to the documents or graphics. 
 
 

3.3.15 Get Network Case Number 

If Get Network Case Number is set to Yes, new cases are given a network case 
number.  Get Network Case Number is useful in establishing a case number prior 
to sending the case to the network database.  (This can cause a case to open a 
bit slower since it has to request the next available number from the network.) 
However, if Get Network Case Number is set to No, the cases will have a 
negative number while stored on the local database. (Network case numbers are 
always positive.) Once the case is moved from the local to the network database, 
it will be given the next available network case number. 
 
 

3.3.16 Bypass Local Database 

Setting this option to yes will set this TOXICALL® installation to make all case 
changes directly on the network database, rather than on the local database. 
 
WARNING 1:  If your system is set to yes, you will not have the option of working 
locally within TOXICALL® in the event of loss of connectivity to the network 
database. 
 
WARNING 2:  You will still need to have a toxiloc.mdb in your TOXICALL® 
installation directory.  Do not delete the toxiloc.mdb file. 
 
 

3.3.17 Max Open Case Windows 

Max Open Case Windows allows the user to specify how many cases can be 
simultaneously displayed in TOXICALL®. This setting depends heavily on your 
specific workstation configuration. With older or slower workstations you may 
find that the actual maximum of displayed cases is only 1 at a time.   
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If too many cases are displayed, an error message may be displayed, typically, 
‘Error 743, unable to load control.’  If this error message is displayed, lower the 
Max Open Case Window setting and the issue should be resolved. It is also 
possible that the machine will seem to lock or kick you out of TOXICALL® if you 
have exceeded your system’s available memory. 
 
 

3.3.18 Write Error Log 

This option allows the user to determine if TOXICALL® will write its errors (as 
they occur) to a log file. It is recommended that this be set to Yes.  In the event 
that you do experience errors in TOXICALL®, you will be able to send this file to 
TOXICALL® Technical Support. If set to No, errors will not be logged. 
 
 

3.3.19 Keep Search Criteria 

Setting Keep Search Criteria to Yes will prevent TOXICALL® from deleting  
search criteria between searches.  This allows a drill-down capability as you can 
continue to add additional criteria to the current search.  Setting Keep Search 
Criteria to No will instruct TOXICALL® to automatically clear search criteria when 
restarted or when the Search window is closed. You may need to uncheck the 
Clear Search Criteria checkbox on the Search window as well.  
 
 

3.3.20 Spell Check 

Spell check has three settings:  Not Enabled, Microsoft Word and Spell Check. 
Choosing Not Enabled will cause your Open Notes field to not be spell checked. 
The Microsoft Word option can be set if you have Microsoft Word 97 or greater 
installed on your system. It will use that program’s spell checker. If you prefer, 
you can also set this option to Spell Check, which uses TOXICALL®’s own built-
in spell checker, which incorporates a medical dictionary and has improved 
performance over the Word spell check.  
 
 

3.3.21 Spell Check While Typing 

When set to Yes, this option allows spell check to occur as the user types. When 
a word is unrecognizable it will be displayed in red type, which indicates that the 
word has been misspelled. When this option is set to No, spell check will not 
operate. 
 
 

3.3.22 SQL Default Max Cases 
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If using SQL for your network database, it is possible to limit the number of cases 
returned by a search. By entering a number in the SQL Default Max Cases field, 
the search will only return up to the number of cases specified, even if there are 
more cases that meet the criteria. Example: Set to 500, but the search would 
normally return 750 cases. You would only see the 500 TOXICALL® found first 
that match your criteria.  

Note: If you are using Access for your network database, this option is set on the 
Search window by checking the check box to the right of the Search Name 
dropdown list. Be sure to double click the field after entering the Max Case 
Number in order to set it.  When asked if you would like to set it, click Yes. 
 
 

3.3.23 Show All Scenarios 

When this option is set to Yes, it displays all scenarios within TOXICALL®, when 
set to No it only displays the AAPCC required scenarios. 
 
 

3.3.24 Scale Case 

Setting Scale Case to Yes allows TOXICALL® to dynamically adjust the 
TOXICALL® Case Entry screen sections and font sizes and thus displays more 
of the text without having to use scroll bars. When Scale Case is set to No, 
scroll bars may appear in fields that otherwise would have been automatically 
resized for you.  

When Scale Case is set to Yes it may take longer to open cases due to the use 
of additional system resources.  If cases are too slow when opening you may 
want to set Scale Case to No. 
 
 

3.3.25 Scale Summary 

Works the same as Scale Case, but affects the Case Summary window only.  
 
 

3.3.26 Lab Note Action 

If your center has enabled the TOXICALL® Lab module, this setting will control 
what is done with the lab entries within cases.  There are 5 possible settings. 
 

• No Case Note – This setting will not write lab data to the notes field at all, 
only storing it within the lab module screen. 
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• Add Written Note – This setting will write the lab data directly to the written 
notes field.  (The blue note field in the top left corner of the case screen) 

• Prompt Written Note – This setting will ask you if you wish to save the lab 
data into the written notes field. 

• Add Open Note – This setting will write the lab data to the open notes 
field.  (The white note field in the bottom left corner of the case screen) 

• Prompt Open Note – This setting will ask you if you wish to write the lab 
data into the open notes field. 

 
3.3.27 Zip Code Release 

This option has three settings: Always, Prompt and Never. Due to the size of the 
Zip Code table, it can take a considerable amount of time to release. If you would 
like TOXICALL® to determine when the table is out of date and therefore be 
automatically released, set this option to Always.  

If you would like the user to determine if it should be released, set this option to 
Prompt. Then, when TOXICALL® thinks the Zip Code table should be released 
it will ask the user if they would like to update it.  If the user selects Yes, the Zip 
Code table will be released; if they select No, the Zip Code table will not be 
released.  

If you would not like the Zip Code table to be released or prompt the user, select 
Never. With this selection, the user will have to manually release the table 
through System Tables in order to update it. 
 
 

3.3.28 Menu Animation 

This option allows you to set the animation type of dropdown lists in TOXICALL®. 
The choices are:  None, Random, Unfold, Explode, and Fade-in. 
 
 

3.3.29 First Control in Case 

This option allows the user to set the field that the cursor will reside in when a 
new case is first opened or an existing case displayed on your workstation. 
Example: If your SPI’s typically ask for the caller name first, set First control in 
Case to Caller Name.  

The available settings for this option are:  Caller Name, Open Notes, Patient 
Name, QA Notes, Call Type, and Substance Verbatim. 
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3.3.30 Scen. Vapor Req. 

This option allows vapor substances to trigger a required Vapor Scenario before 
the case can be closed, if desired. 
 
 

3.3.31 Scen. Pesticide Req. 

This option allows pesticide substances to trigger a required Pesticide Scenario 
before the case can be closed.  
 
 

3.3.32 Route Value Types 

Setting this to AAPCC will mean that within the case window, AAPCC defined 
routes will appear when you are choosing routes of exposure.  Settting this to 
User Defined will mean that user defined routes will appear when choosing 
routes of exposure. 
 
 

3.3.33 CE Value Types 

Setting this to AAPCC will mean that within the case window, AAPCC defined 
Clinical Effects will appear when you are choosing Clinical Effects.  Settting this 
to User Defined will mean that user defined Clinical Effects will appear when 
choosing Clinical Effects. 
 
 

3.3.34 TH Value Types 

Setting this to AAPCC will mean that within the case window, AAPCC defined 
Therapies will appear when you are choosing Therapies.  Settting this to User 
Defined will mean that user defined Therapies will appear when choosing 
Therapies. 
 
 
 

3.3.35 Scenario Value Types 

Setting this to AAPCC will mean that within the case window, AAPCC defined 
Scenarios will appear when you are choosing Scenarios.  Settting this to User 
Defined will mean that user defined Scenarios will appear when choosing 
Scenarios. 
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4 Initialization File Settings 

The toxicall.ini file stores workstation configuration information, such as the 
location of your network database, whether or not you can renumber cases and 
the settings from the TOXICALL® Configuration window. 
 
 

4.1 Opening and Modifying the 
TOXICALL®.ini file 

To access the toxicall.ini file: 
 

• Click the Start Button  from the Windows taskbar and choose Run 
from the menu 

• In the window that opens type:  toxicall.ini 
• Click OK and the file will open in a Notepad window 
• Enter the line for the functionality you would like to add in the 

[Configuration] section(see options below) 
• Select the File menu and click Save, then close toxicall.ini 

 
 

4.2 Automatic Upgrade 
Automatic Upgrade allows TOXICALL® to run an update when it detects that a 
newer version is running on one of the workstations in the network. When set to 
run automatically, it will run the upgrade as soon as it detects a newer version 
and use the default locations for database installation. It can also be set to ask 
the user if they would like to upgrade. If they select Yes, TOXICALL® will begin 
the upgrade and will ask the user for the installation locations of the local and 
network databases. If they select No, the upgrade will not run and the user will 
not be able to use TOXICALL® until the upgrade has been run. 
 
The two lines to enter in the toxicall.ini are: 

• AutoUpgradeFile=ToxicallUpgradepath 
Example:  AutoUpgradeFile=D:\ToxUpgd\Tox4Upgd.exe 

• AutoUpgradePrompt=x Where x is 0 (no user input), or 1 (prompts user to 
upgrade).  If this is not entered, it will default to 0 

 
 

4.3 Automatic Database Repair 
TOXICALL® automatically repairs and compacts the local database every three 
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days. This can be set to a different timeframe, if desired. The line to add is:  
 

• LocalDBRepairDays= x  Where x is the frequency, in days, that you would 
like TOXICALL® to automatically repair and compact the local database.  
If set to 0, it will never be repaired and compacted automatically 

 
 

4.4 Clear QA Notes 
Adding this option will automatically clear the QA Notes field when a case is 
saved with a status of Closed. To add this functionality:  
 

• ClearQANotes=1 If this option is missing or set to 0, then QA Notes field 
will not be cleared when a case is closed 

 
Note: TOXICALL®’s default behavior will not save QA Notes when the case is 
closed. 
 
 

4.5 Open Case From Current Database 
This option allows a user to open and edit a case without having to first bring the 
case into the local database. Thus, it is possible to open and edit cases within an 
archive database. To enable this, enter: 
 

• NetworkCase=1 If NetworkCase=0, this option is disabled 
 
Note: this does not lock the case from other users opening it.  
 
 

4.6 Renumber Case 
This option allows a Supervisor to be able to change the case number, center 
number or year code for a particular case. This option will appear in the 
Supervisor menu on the Search window. To enable this enter: 
 

• ReNumberCase=1 If ReNumberCase=0, this option is disabled 
 
 

4.7 Override SQL 
This option will allow you to see the SQL Select statement that will be passed to 
the search engine to return your record set. To enable this, enter: 
 

• OverrideSQL=1 
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5 System Tables 

TOXICALL® uses system tables which allow site specific data customization. 
Supervisors have the ability to add, modify, inactivate, and in some instances 
delete entries. All system tables function in the same manner.  The creation, 
modification, deletion or the inactivation of entries in the majority of the system 
tables will require that many of the same steps be taken.  

Note1: In order for entries to be eligible for deletion, they must not be 
needed to resolve historical data.  

Note2: If you are using SQL you will only see the second system table name 
listed in the heading. 
 
 

5.1 Working with System Tables 
 
 
 

5.1.1 Opening System Tables 

 
 
To open system tables:  
 

• From the main TOXICALL® screen, select the Tools menu and click on 
System Tables 
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• Select the system table by either single clicking the table and clicking 
Show, or by double clicking the system table 

 
 

5.1.2 Viewing system Tables 

 
 
System Tables can be viewed in List or Detail View.  List View (the first graphic) 
will show all the entries for that particular system table and users can sort on any 
column in the view. The Detail View (the second graphic) is used to modify or 
add entries to the system table. 
 
 

5.1.3 Adding a New Entry to a System Table 

Click the New button and it will open the appropriate data entry screen for the 
System table.  The below example shows the data entry screen for the UHCF 
table. 
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Enter the appropriate information (for details see the section pertaining to the 
system table you will be modifying). 
 
The UHCFName field at the top of the List View and Detail View screens is used 
as a quick search box—enter all or part of the entry you are looking for and 
TOXICALL® will move you to that entry, or if not found, to the one closest to 
where it would be.  

The HCF Number, like other identifying numbers in other tables, is a user defined 
number but must be unique. To check for unique identifying numbers, you can 
sort the List View page on the number used for that table and then verify which 
number should be used next.  

The Name field is the text that will be displayed in the dropdown list in 
TOXICALL®.  
 
Save the changes using the Save button, then click the List View radio button to 
go back to the list view.  It may ask you if you would like to save your changes.  
Click Yes. 
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When you have finished editing the system table, close the system table by 
clicking the x button in the upper right corner.  The message box below will 
appear. 
 

 
 

Click Yes. This will bring up a verification screen that asks if you are sure you 
want to release the table.  Click Yes.  

This will return you to the System Table window. Notice that the Last Released 
Date field for the SearchDataLoc table is red, indicating that is to be released 
when this window is closed.  

Click the Close button at the bottom of that window, which will open a new 
window saying that system information is being transferred. When it completes, 
you will see:  
 

 
 

When TOXICALL® is reopened (and restarted on the other workstations), the 
changes made will be visible. 
 
 

5.1.4 Inactivating Entries in a System Table 

 
 

As with most relational databases, TOXICALL® uses values in one table to 
resolve values in other tables. Therefore, deleting items can cause problems. 
Because of this potential problem, many of the system tables will not allow data 
deletion. However, entries may be inactivated. This allows the data to remain 
available for historical cases, but remove it from dropdown lists so it cannot be 
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used in new cases. If need be, the entry can be reactivated later.  

To inactive a system table entry, open the appropriate system table.  Double click 
the entry to be inactivated to display the Detail View and click the Inactive check 
box.  Save the change, close the window, release the table and close the System 
Tables window to begin the table’s release. 
 
 

5.1.5 Deleting Entries from System Tables 

Embedded case data is the only kind of data that can be deleted from system 
tables.  An example would be a template.  Once a template has been applied to 
a case, it is embedded within that case. Deleting embedded case data will not 
affect cases already containing the data, it will only prevent its further usage.  
 
To delete an entry open the appropriate system table.  Double click the entry to 

be deleted to display the Detail View and click the Delete button . You can 
also delete the entry in List View by highlighting the entry and clicking the Delete 
button. 
 
 

5.1.6 View Levels – Assigning Rights 

View level rights determine what each user has permission to view, access and 
modify in TOXICALL®. View level rights must be declared for each SPI, and are 
assigned via the SPI list and Security Information system table. The meaning of 
view levels is user defined. Therefore, your site can decide if you think that 
Level1 should be the highest or Level 4 should be the highest.  For the purposes 
of this discussion, we will use Level 1 as the lowest level security and Level 4 as 
the highest level. The view levels for the different views/reports/databases are 
set in the Views and Reports system table.  
 
Example:  Your site needs an archive database and only wants Supervisors with 
View Level 4 to be able to access it. To accomplish this, simply assign the 
archive database View Level 4 in the Views and Reports system table and make 
sure that only your Supervisors have View Level 4 set in the SPI List and 
Security Information table.  
 
For more information, see the section regarding this system table, later in this 
chapter. 
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5.2 SearchDataLoc 

The SearchDataLoc table allows supervisors to create new databases, which can 
be used for archiving to aid in database management. These databases can also 
be used as destination databases to copy cases into, as well as for sharing 
cases with other centers running TOXICALL® for research.  View levels can be 
set for each database to control access by users.  For more information see the 
section View Levels-Assigning Rights.    
 
Supervisors can create new archive databases, assign rights, and change the 
location of the newly created database.  Creating a new archive file involves 
declaring a name for the dropdown to display from within TOXICALL®, pointing 
the database to the file location, setting the appropriate View Levels and 
copying system tables.  
 
After opening a new entry screen in the SearchDataLoc system table, you will 
want to define a name for the new archive that will appear in the Location 
dropdown box in the Search window of TOXICALL®. This name can contain 
spaces and most characters as necessary. 
 
Next select the View Levels that will be able to access this archive file.  The 
appropriate levels to select depends on your site’s restrictions to archive files and 
also on your View Level scheme that you have established.  
 
Next, click the Lookup button  next to the File field.  The next screen is shown 
below.  If you are using an Access network database, you will choose Microsoft 
Access as your database type.  If you are using SQL, you can choose either 
Microsoft Access or SQL Server as your database type. If you choose SQL, be 
sure that your SQL Administrator has set up the database for you.  You will need 
to know the name of the SQL Server it is on, the name of the database, login and 
password.  For more information, refer to the SQL Server Setup documentation. 
This document will follow the path of creating an archive in Access.  
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Click the Lookup button next to the File field again. This will open a browse 
window, from which you will need to browse to your desired directory. Make sure 
this file is in a location where everyone who will have access to it will be able to 
reach it.  A UNC path or drive letter mapping can be used to connect the 
database with the workstations.  When you are in the correct directory, type a 
filename for the database in the Name field at the bottom. This will be the actual 
file’s name and therefore should not contain spaces or other reserved symbols. 
When done, click the OK or Save button.  
 

 
This will take you back to the previous window.  Click OK. This will open a 
message box similar to the one below.  Click Yes.  
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It will pop up a warning message reminding you to copy system tables so that 
data will resolve.  Click OK.  When it brings you back to this screen you are ready 
to save the file and close as described in the Adding New Entries section.  When 
you have reopened TOXICALL®, go to the Tools menu and select Copy System 
Tables. The window will ask you for the source and destination databases. The 
source should be set as your network database and the destination as your new 
archive database (which should now be visible in the dropdown).  Click Start and 
then OK in the message box that alerts you that this action cannot be aborted 
once started. A series of windows stating that they are transferring system 
information will be displayed. When complete, it will give a new message box that 
TOXICALL® will now exit.  Upon restarting TOXICALL®, the archive file is ready 
to use.  
 

 
 

This step is necessary to copy information from your network database over to 
the new database such as SPI Names and numbers and other customized fields. 
If this step does not occur, you will see fields with <xx Not Resolved> as the 
contents instead of the proper value. You will also need to copy the system 
tables to all databases whenever you make changes to them, such as adding a 
new SPI or a new health care facility in order for those additions to be visible. 
 
 

5.3 CodeValueUser 
With the CodeValueUser table, sites can create, modify or inactivate site-
specific call types, case statuses, caller/patient titles and case priorities. After a 
center creates new code value option, it can be used as criteria for a search.  It 
can also then be set as a required field if desired. For more information see the 
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Searching document and the Required Fields system table section of this 
document.  
 
Site-specific call types can be associated with AAPCC call types.  For example, a 
center might create a new call type of Animal Exposure and relate it to Exposure.  
 
Toxicall’s® save statuses are Open, Closed, Retroactive and Quick Save.  Site 
specific save statuses allow a site to categorize calls to better meet their needs. 
For example, a site might create a Ready for QA Review status.  
 
Site-specific caller/patient titles allow the site to use more specific titles if desired. 
For example, a site may choose to add Senor, Monsignor or Sergeant as new 
titles.  
 
Currently, TOXICALL® uses High, Medium and Low as case priority levels. 
Site-specific priorities allow a center to more specifically categorize calls.  For 
example, a site may choose to create an Urgent or Very Low priority level to 
better distinguish their calls.  
 

 
 

After opening a new entry screen for the CodeValueUser system table, choose 
the Type from the dropdown list (Title, Status, Call Type, or Priority), in the Value 
field enter the new item you would like to add, and in the Category field, enter an 
AAPCC category, if you would like to associate your new code to a category. The 
Value must be unique.  To see a list of AAPCC categories, click on the List View 
radio button at the top of the window.  Now, just save, close and release as 
instructed in the Adding a New Entry section. 
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5.4 FreeAreas 

The Free Areas are designed to be used by each center for custom data that 
the center would like to collect. It has been used for such items as caller 
language, attending doctors, public ad material, and QA/QC information.  
 
There are seven free area fields: 1, 2A, 2B, 2C, 3D, 3E and 3F.   Each has a 
value length limitation of 20 characters, including spaces.  Fields can be created, 
modified or inactivated.  
 
To create a new Free Area Information field, first open the new entry screen of 
the FreeAreas system table.  Choose the Free Area field number that you would 
like the information to appear in from the dropdown.  Next enter the Seq. number 
of the first choice for the field. The sequence number will determine in which 
order the item will appear in the dropdown and thus must be unique. If the data is 
to be scanned to the AAPCC, enter an AAPCC scan code. This is a unique user-
defined number between 1 and 32767. Then enter your value to be displayed in 
the dropdown. Lastly, save, close and release the table as explained in the 
Adding a New Entry section.  

 
 
 

5.5 UHCF 
This system table enables each site to enter customized health care facility data 
such as name, address, county, contact information, three phone numbers and 
notes about the facility. The notes field can be handy to include information such 
as the facility’s restrictions, specialties or to identify the phone numbers by 
department. Entries can be created, modified or inactivated in this table. 
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Health Care Facilities numbers are selected and entered by each site, and each 
number must be unique.  The Health Care Facilities numbers are grouped by 
facility type according to the table below.  
 

1 – 999  Acute Care Hospital  
1000 – 
1999  Free Standing ER  
2000 – 
2999  Physician/Office/Clinic  
3000 – 
3499  Nursing Home/Chronic Care  
3500 – 
3999  NP/PA/Midwife/Dentist  
4000 – 
4499  

RN/LPN/School or Occupational 
Nurse  

4500 – 
4999  Ambulance/EMT/Hazmat/Police  
5000 – 
5499  Detox/Mental Health  
5500 – 
5999  Pharmacist  
6000 – 
6499  Veterinarian/Animal Hospital  
6500 – 
6999  Vehicles  
7000 – 
9999  Other  
 
To add a Health Care Facility, first open the new entry screen of the UHCF 
system table. Enter a unique HCF number for the appropriate type of facility. 
Enter the name of the HCF as you would like it to appear in the HCF list box in 
TOXICALL®.  Fill in the other information as you would like available in the HCF 
lookup box.  Lastly, save, close and release the table as explained in the Adding 
a New Entry section.  
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5.6 Keycuts 
Keycuts are shortcuts that can be used in the Open Notes field of the Case 
Entry window and can contain commonly entered data or site-specific data. For 
example, a site might use a keycut for instructions for bee stings or for 
questions to be asked in drug information calls. Entries can be created, 
modified or deleted. New keycuts can also be created by users with 
appropriate rights from the Case Entry window, for more information, see the 
User manual section on Keycuts.  
 

To create a new keycut using the Keycuts table, open the system table to the 
new entry screen.  Assign a name for the keycut which will appear in the Keycuts 
lookup table in the Case Entry screen.  Enter the text as you would like it to 
appear in the Open Notes field. Lastly, save, close and release the table as 
explained in the Adding a New Entry section.  
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5.7 Zip Codes 
TOXICALL® ships with a table that contains national zip code information. 
Performing a zip code or area code lookup will enter the area code, city, state, 
zip code and county information.  If your site uses Area Code/Exchange it is 
recommended that you check the table to be sure that all the entries you need 
will be there.  As the phone company changes area codes, and the Post Office 
defines new zip codes, these will need to be added to your table in order for them 
to be visible.  Entries can be created, modified or deleted from this system table.  
 

To add a new zip code or area code, open the ZipCodes table to the New Entry 
screen.  Enter the information in the fields. FIPS is used by the US Post Office 
but is not required or used by TOXICALL®. Preferred is used to set the preferred 
city for a zip code with multiple city listings.  To set a site as Preferred, enter P.  
To set it as Not Preferred, enter N.  Lastly, save, close and release the table as 
explained in the Adding a New Entry section.  
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5.8 Required Fields 
This system table allows each center to require specific fields that are not 
required by the AAPCC. Entries here will not override the AAPCC required 
fields. Required fields are based on call types and are customized by each 
center. Entries can be created, modified, inactivated (changed to not 
required) and deleted.  New required fields can help your center track 
such information as site of exposure, weight of patient, or gender of caller.  
To add a new required field, open the RequiredFields table to the New 
Entry screen.  Choose which call type you would like to trigger the 
requirement from the dropdown. The entire list of call types is listed or you 
can choose (All) if you would like all calls to include this information.  Next, 
choose a required field from the dropdown list. If you would like to require 
more than one field, you will need to create a separate Required Field 
entry for each specification. Make sure the Required checkbox is checked.  
Lastly, save, close and release the table as explained in the Adding a New 
Entry section.  
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5.9 SPIList 

The SPI List table allows users to enter new users and set up their permissions 
for specific TOXICALL® functions and databases using view levels. (See the 
graphic below for the rights that can be assigned.) User Passwords are set in the 
SPI List, and in the Security Information system table. User’s network login 
names can be added to allow users to log into TOXICALL® without entering their 
password (this can only be used in centers where SPI’s log into the computer 
with unique login names). Entries can be created, modified or inactivated.  
 
To add a new SPI, open the SPIList table and sort the entries on SPI Code to 
determine which is the next number to assign. The SPI Code must be a unique 
number. Also sort on SPI Name to make sure no one else has the same first 
name as this must also be unique. Next, open the New Entry screen and enter 
the information as requested.  Do not enter a Network Logon Name if you will not 
be using this feature.  Assign the appropriate rights according to your center’s 
rights schema.  Then, set a Default Search Name for the user, if desired. This 
search name will automatically appear in the Search Name dropdown when they 
go to the Search window, if set.  Lastly, save, close and release the table as 
explained in the Adding a New Entry section.  
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5.10 TemplateList 
Templates can be created and used for common calls or multiple case calls, and 
are created in TOXICALL® by SPIs in the Case Entry window.  For more 
information, see the Templates section of the User manual. Users can change 
the name of the entry or delete an entry from this system table.  To modify, open 
in Case Entry window using Apply Template from the File menu.  
 

To change the name of a template, open the TemplateList table, and double click 
on the entry to change the name. In the window that opens, modify the name in 
the Template Name field. Lastly, save, close and release the table as explained 
in the Adding a New Entry section.   

 
 
 

5.11 SearchViewList 
Views, displays and reports are assigned View Levels in the SearchViewList 
table. Each view and report is available to assign rights to in this table. 
Supervisors can assign the View Level to individual SPI’s via the SPI List table.  
 
Example:  If a site has determined that Case Detail Report may be accessed 
only by users with View Level 4, simply double click the field of Case Detail 
Report to open the modification window and click the View Level 4 box.  

.  
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6 Supervisor Functions 

Supervisor functions are performed from within the TOXICALL® application and 
are limited to users with supervisor rights, which are declared in the SPI List. 
These functions include the ability to unlock cases, delete cases, manually scan 
cases to AAPCC, as well as change a machine’s Configuration window. Without 
supervisor rights, a user will only be allowed to change their password and 
repair/compact the local and network databases. 
 
 

6.1 Tools Menu from Main Window 

 
Only users with Supervisor window rights will have access to system tables, 
which are accessed via Tools on the menu bar.  
The majority of all supervisor functions will be performed from the Tools menu.  
To access Supervisor functions if the search window is open, close it by 
choosing File / Close Search Window, then choose Tools from the menu bar.  
If there are case windows open, close these by choosing File / Save Case. 
 
 

6.1.1 Data Migration 

If your database was created with TOXICALL® 3.6 or 4.0, data must be migrated 
prior to using the data in TOXICALL®4.3. See the TOXICALL® Migration Guide 
for additional information.  
 
Also when upgrading from version 4.3.7 or higher to 4.3.45, databases  
need to be checked for TESS 2002 fields option in this menu. 
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6.1.2 Repair and Compact 

This feature is used to prevent and fix database corruption. It should be run 
regularly for sites that are using Access network databases and have a high call 
volume and run periodically for all other sites using Access network databases. It 
is not used with SQL Server network databases. This option will also allow you to 
repair and compact any other database that is using Access, such as archives, or 
your local database.  The repair attempt to fix data corruption errors, while the 
compact removes extra space in the database, which helps improve database 
performance by shrinking the database size.  

 

To run a repair and compact, select this option from the Tools menu. Then 
choose the appropriate database from the dropdown window.  It is recommended 
that you also check the Compact and the Create Backup checkboxes before 
running the repair and compact.  As stated above, the compact allows the 
database to try to maximize it’s performance. The backup creates a backup file 
with the same filename as the database you are fixing with a .SAV extension. For 
example, if you were performing this on the network database, Toxinet.mdb, the 
backup file would be Toxinet.SAV.  Each time the repair and compact is run, the 
previous .SAV file for that database will be overwritten with the new backup 
information.  
 

Please be aware that when the backup option is checked, TOXICALL® will need 
twice the file size available as free space. If you run it without that required 
space, it will not complete successfully. If you do not have enough space you can 
run the repair and compact without selecting the Backup option, but it is highly 
recommended that you create a backup copy of your database elsewhere before 
performing this operation. If you choose to run without the Backup option, a 
warning message will appear reminding you to be sure you have a current 
backup available.  

When you have completed these steps, click the Run button. A message will 
appear asking if you are sure you want to compact and repair, click Yes. If it 
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completes successfully a message box will appear stating this.  If you get an 
error, please see Database Corruption under the Troubleshooting section in this 
manual. 
 
 

6.2 File Menu from Search Window 

 

The File menu from the Search window includes some options only available to 
users with Supervisor rights.  These include Move/Copy Cases, Scan Cases 
In/Out, and Export Cases. 
 
 

6.2.1 Move/Copy Cases 

This option allows the user to move or copy cases from one database to another.  
This is helpful when cases need to be moved from the network database to 
another database, such as an archive file, in large numbers. It is also useful 
when working on special reports concerning a batch of cases. Simply copy the 
cases from the network to the archive created for the report and work on them as 
needed without locking the cases for other users.  
 
To use this option, first run a search on the cases that you’d like to move/copy.  
For archiving, use the appropriate option in the Search Name dropdown list.  For 
a special report, enter the needed criteria and run the search. Then go to the File 
menu, choose Move/Copy Cases and select the Destination Database. You can 
specify either All Selected Cases (cases that are highlighted) or All Displayed 
Cases. If you would like to copy cases, check the Copy Cases checkbox. If you 
are moving cases to an archive database and would like to update the system 
tables, check the Copy System Tables checkbox.  When you have completed 
these steps, click OK. The cases will now move.  
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6.2.2 Scan In/Out 

This option opens a Scan In/Out window with several choices.  Cases 
can be scanned in from another data source (provided they use the same 
format as TOXICALL® or TESS). They can also be scanned out, usually 
this is used for manually sending a center’s data to the AAPCC’s TESS.  

WARNING:  Do not scan ANY data into TOXICALL® without first 
contacting TOXICALL® Technical Support.  

To scan data into a TOXICALL® database, click the File menu and select 
Scan Cases In/Out.  Click on the appropriate Scan Type.  Click on the 
lookup button to the right of Scan in Source File, and select the database 
to be scanned in.  Click on the down arrow to the right of Scan in 
Destination database and choose the destination database for the data 
and click Start.   
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To scan data out from a TOXICALL® database, open the database that contains 
the cases to be scanned out and perform a search to locate the specific files to 
scan out.  Click the File menu and select Scan Cases In/Out. Click on the 
appropriate Scan Type. Click on the lookup button to the right of Scan Out 
Destination File.  Locate or create a filename for the file to hold the scanned out 
cases. Select either Append to Existing File or Overwrite Existing File. Choose to 
either scan out Selected Cases or All Displayed Cases.  If you may have 
previously scanned these cases, but would like to scan them again, check the 
Ignore Scan Flag Status checkbox. Click Start.  

If you will be sending this data to the AAPCC manually, you will need to establish 
an ftp connection to their server and login with your center’s login and password. 
 
 

6.2.3 Case Validation Report 

Autoupload supersedes this functionality. The Case Validation report 
option is under review for possible future use.  

 
 
 

6.2.4 Export Cases 

This can be used to share data with different applications, if necessary.    
 
To export a case list to a file, have the necessary cases selected on the Search 
window.  Click the File menu and select Export Cases.  In the window, choose 
the type of file to create in Export Type. In Export File, if you do not have an 
existing file you’d like to send it to, you can create one here just by clicking the 
Lookup button, directing the file to the correct folder using the browse window 
and typing in a new name. Under Data Options, select which cases are to be 
exported.  Under Layout Options, determine which options you’d like included 
with the file and under ASCII File Options, you can select different field delimiter 
or separators, if desired. When done, click Export. A window will ask if you would 
really like to export cases, click Yes, and another window will appear when the 
process is complete to notify you, click OK.  

Note:  This method does not export case Notes.  
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If you have a report generated that you would like to export to a file, this can be 
done with the same method. The window that appears after clicking Export 
Cases is a little different though (see below).  Here you are just prompted for the 
format, name and location for the file. Note that there are also several file format 
options for your reports.  The Adobe Acrobat (which requires Adobe Acrobat 
Reader--a free download from Adobe.com--to view) and Microsoft Excel are 
probably the most common choices from the list. When done, click Save and it 
will create the file.    
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6.3 Supervisor Menu from Search Window 
The Supervisor menu in the Search window allows Supervisors to manipulate 
cases including deleting, renumbering, and unlocking cases. 
 
 

6.3.1 All Selected Cases 

The following options when chosen from the dropdown will affect all highlighted 
cases in the currently displayed database.  
 

 
 
 

6.3.1.1 Unlock Cases 
This option allows a Supervisor to unlock cases.  Cases are generally locked 
when they are opened on a user’s workstation in their local database. This is to 
maintain data integrity by not letting two users save changes to the same case at 
the same time.  When a case is unlocked it is important to remember that if the 
case is sent back up to the network from another workstation that did have it 
open, that case will overwrite any changes made by other users in the meantime. 
Therefore, whichever case was sent up to the network last becomes the new 
version.  
 
 

6.3.1.2 Reset Scanout Flag 
This option allows the Supervisor to reset the scanout flag, which will allow the 
case to be re-scanned out, even if it was previously uploaded.  Please note that 
every time a change is made to a case, it also resets the scanout flag. 
 
 

6.3.1.3 Delete Cases 
This option allows the Supervisor to delete selected cases from the database.    
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6.3.2 All Displayed Cases 

The following options when chosen from the dropdown will affect all cases in 
the currently displayed database.  
 
 

6.3.2.1 Unlock Cases 
This option allows a Supervisor to unlock cases.  Cases become locked when 
they are opened on a user’s workstation.  Locking maintains data integrity by not 
letting two users make changes to the same case at the same time.  If a case is 
unlocked, and sent back up to the network from another workstation that had it 
open, that case will overwrite any changes made by other users in the meantime. 
Therefore, whichever case was sent up to the network last becomes the new 
version. 
 
 

6.3.2.2 Reset Scanout Flag 
This option allows the Supervisor to reset the scanout flag, which will allow the 
case to be re-scanned out, even if it was previously uploaded.  Please note that 
every time a change is made to a case, it also resets the scanout flag. 
 
 

6.3.3 Case List 

This option allows the Supervisor to affect the way the Case List is viewed on a 
particular machine.  
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6.3.3.1 Hide/View Columns 
Using this option will open a list of all the possible fields that can be displayed in 
the Case List view.  Supervisors can change which fields are displayed by simply 
checking the checkbox next to the fields you would like displayed and 
unchecking the checkbox next to fields you would like to hide. 
 
 

6.3.3.2 Save Layout 
This option works with Restore Layout.  Save Layout will save the changes made 
with the Hide/View columns for use every time that TOXICALL® is reopened.  
 
 

6.3.3.3 Restore Layout 
This option works with Save Layout.  Choosing this will reset the Case List view 
back to the default view and remove any changes made in Hide/View columns. 
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7 Autoupload 

After opening Autoupload on the designated machine, it must be left open in 
order to run.  It can be minimized down the task bar so that you can continue with 
other work on this machine.  Autoupload automatically sends cases to the 
AAPCC on a configurable schedule using an ftp connection. Generally, these 
cases are gathered from the network database.  Any time a change is made to a 
case, it will reset the scanout flag and when Autoupload searches for cases to 
send to the AAPCC, it will include that case and overwrite previously sent 
versions of that case. After Autoupload has gathered the cases and sent the file 
(which you can watch occur through the Autoupload log window), it will wait up to 
50400 seconds for the acknowledgment file from the AAPCC.  (Normally this 
should take just a few minutes.) The acknowledgment file then will return and will 
inform you of the total number of cases sent, the total number accepted and the 
number rejected.  If a case is rejected, it will update the status in the network 
database to Rejected.   

If you would like to check your network or an archive for cases that have not 
been scanned out with Autoupload, you can run a Search on the suspect 
database with Case List-Advanced. On tab 2, Case Information, uncheck the 
checkbox in the right hand column labeled Scanout Status.  If you check this box, 
it will search for cases that have been scanned out. Do not worry if you do find 
some cases that have not yet been scanned. This is normal as it can take a few 
minutes to send them to the AAPCC.  Check back later to make sure they have 
scanned out.  If they have not, contact Toxicall Technical Support.  

Note: It is no longer necessary to run a Case Validation report before sending 
cases to the AAPCC 

Autoupload can also be used to send data to other locations, such as a State 
Health Department.  The receiving end must have TOXITRACK® to use the 
autoupload functionality.  Please contact us at support@toxicall.com for more 
information on this functionality, as well as information on TOXITRACK®.  

To set up Autoupload, please contact Toxicall Technical Support. Support will 
send you a setup file and schedule a time to walk you through the setup and 
testing of Autoupload. 
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8 Troubleshooting 

For sites running the network database on Access, it is recommended to have 
Microsoft Access 97 when using Jet 3.51 or Microsoft Access 2000 when using 
Jet 4.0 database loaded on one or more of the workstations that have access to 
the network database.  It is not necessary in order for TOXICALL® to run, but is 
helpful in troubleshooting Access databases. 
 
 

8.1 Access Database Errors 
Errors received when logging into TOXICALL®, or selecting the network 
database through TOXICALL®, such as those below, are usually caused by 
either the inability of TOXICALL® to locate the network database, or database 
corruption. 
 

• ‘Error: -2147467259 couldn’t find file (path of file) Error Location 
Provider Microsoft Jet OLEDB.3.5.1; Persist Security info=false. 
Datasource=(path of file) Modual: modcommon, Function, 
CASOpenADOconnection,’  

 
• Network database cannot be found  

 
• Toxinet.mdb is not a valid database.  

 
Note: the datasource could list Toxinet.mdb, Toxiloc.mdb or another .mdb file.  
For Toxinet and Toxiloc, follow the instructions below.  For other files, call 
Toxicall Technical Support.  
 
The first thing to check is that TOXICALL® can locate the file: 
 

• Check your Configuration window to verify the network database location. 
Click the Lookup button next to the Network Database Location field. 

• If you are running SQL Server, verify all fields with a machine that is 
working. If no machines are working contact your IT department and let 
them know you are unable to access the SQL server.  If your SQL lines 
are the same as a working machine, see the next step. 

• If you are running Access, click the next Lookup button. Verify that you are 
in the same directory that was specified in the Configuration window for 
this machine’s Toxinet.mdb.  Toxinet.mdb should be visible in this 
directory.  Double click it to select it again, click Save or OK in the next 
window and Save in the main Configuration window. Try to open 
TOXICALL® again.  If you can’t get to the Toxinet.mdb mapped path 
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through TOXICALL®, check the path with a working machine.  If the non-
working machine has a different path, modify it to match the working 
machine. If it has the same path defined, try to access it through My 
Computer.  If you are not able to access it this way, there may be a 
problem with your network connection. You can try to reboot your system 
to see if it comes back, or you may have another problem which will 
require your IT department to fix. If all your workstations are having trouble 
accessing the network database this way, you may have a larger network 
problem. Contact your IT department. 

• If this problem is happening on all machines and they have the correct 
path to the network database and it can be located through the 
Configuration window, you may have a corrupt network database. 

 
 

8.1.1 Database Corruption 

Database corruption is not uncommon with Access databases that are handling a 
lot of transactions. It can occur with either Access or SQL databases, but we 
have found that sites with high call volumes that run the network database on 
Access, have database corruption issues more frequently.  There are other 
causes for this as well.  For more information, please visit Microsoft online at 
www.microsoft.com.  This document will discuss how to fix Access databases.  
Repairing SQL databases is the realm of the database administrator and beyond 
the scope of this manual. Running a repair/compact on the network database will 
generally resolve these issues.  

If you have a corrupt database, follow the steps below: 
 

• In TOXICALL®, choose the Tools menu, and then select Repair and 
Compact.  You can also access this option through the Configuration 
window—just click the rounded arrow next to either the network or local 
database (whichever is corrupt). 

• If this does not work, find a machine on your network that has Access97 
installed and open it. Next, go to the Tools menu, then to Database 
Utilities, then select Repair. You will need to direct it to your database that 
is corrupt (usually the network—toxinet.mdb). When the repair completes 
successfully, go back to Tools/Database Utilities and select Compact. 
Again, select the appropriate database. It will ask you what file you would 
like to compact it into, usually it offers db1 as a suggested name. Write 
down the name and make sure you put the file in the same directory as 
the corrupted database. 

• When this completes successfully, go to Windows Explorer, go to the 
directory where the corrupt database and newly repaired and compacted 
database are located.  Right click on the corrupted database and choose 
Rename.  Change the name to include something like ‘Bad’, or ‘Old’ to 
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designate that it is corrupted. Next, find the fixed database. Right click it 
and choose Rename.  Change this name to the name of the old database, 
for example - toxinet.mdb. 

• Close these windows and start TOXICALL®, checking that you do not get 
the same errors as before.  If any of these steps did not work, please 
contact TOXICALL® Technical Support for assistance. 

 
 

8.1.2 Records cannot be read or No Read Access 

When trying a repair and compact through TOXICALL® the following 
message is displayed:   

‘Error: 3356, You attempted to open a database that is already opened 
exclusively by user ‘Admin’ on machine name try again when the database is 
available.’   

Resolution: 
 

• Check to ensure that all computers are logged out of the database being 
repaired/compacted.  If you are repairing the network database, make 
sure everyone is completely out of TOXICALL®. This includes any 
workstations that may be in other areas of the building using TOXICALL® 
or in offices. 

• If all others computers are logged out of the database and the message is 
still being displayed, log all workstations out of TOXICALL®. Once all 
systems have been logged out of TOXICALL® try to run repair/compact. 

• If an error message is still being displayed, go to the network database 
directory and search for a file with the same filename as your database 
with a .ldb extension. This file should be around 1kb in size.  Once the file, 
.LDB, has been located, highlight and delete the file.  
***Warning: Make sure you have the correct file before deleting.*** 

• Run the repair and compact again. 
• If you are still having trouble, contact Toxicall Technical Support. 

 
 

8.2 Unable to Upload Cases to the Network 
If you see an error: ‘Warning: x Case(s) selected and 0 cases moved. Reminder 
Locked cases cannot be moved from the Network database.’ 
 

• This error message may be displayed when trying to move 
locked cases from the network database to another database. 
Locate the person who has the case downloaded to their local 
database and have them send them to the network.  (Note: A 
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Case Status-Advanced search can detail which SPI locked a 
particular case, the date/time the case was locked and the 
workstation at which the case was locked.) Try again.  

• If no one has the case open, a Supervisor should attempt to unlock it. With 
the cases selected, go to the Supervisor menu and choose Unlock Cases, 
click Yes when you see the warning message box. 

 
 

8.3 <Not Resolved> In Archive Database 
When viewing an archive database, and some fields display the message < XX 
Not Resolved>, it is required that the system tables be copied into the archive 
database.  To do this, select the Tools menu, then Copy System Tables.  Select 
Current Network Database as the Source and set the Destination to the archive 
file that has the error. Click Start and then OK. A series of system tables will be 
displayed on the screen, and eventually a pop up box verifying that the system 
tables have been copied will be displayed.  Select OK to return to the window 
and close it.  
 
 

8.4 Not Running the Current Version of 
TOXICALL® 

This message states that TOXICALL® has been upgraded to a higher version 
number on at least one workstation on your network.  You will have to upgrade 
your workstation to the same level in order to access TOXICALL®. 
 
 

8.5 Problems with Poisindex® 
 
 

8.5.1 Unable to Open Poisindex® 

When unable to open Poisindex from TOXICALL®, make sure that Health Care 
Series has been loaded onto the workstation and TOXICALL®’s path points to it 
correctly. (This is set up in the More window of the Configuration window.) Verify 
the paths for Home Path and Temp Path by checking that you can access the 
files for Micromedex from My Computer, and going to the same directories listed 
in the path. If you are unsure if the path is correct, check the mdxuser.ini file 
located on the workstation. If the path is set correctly, check your Micromedex 
subsmain.exe file to see that you have Poisindex and AAPCC set to Yes. If you 
do not, contact Micromedex for support. 
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A “Padlock Error” error message will require you to contact  
Micromedex for resolution. 
 
 

8.5.2 Poisindex substance not going into 
TOXICALL® 

When a substance has been selected from Poisindex, and is not propagated into 
TOXICALL®, check the HCS Update Interval. Go to the Tools menu, select 
Configuration, click the More button and ensure that the HCS Update Interval is 
set to 2 and that the HCS Temp path is correct. 
 
 

8.6 Rescanning Cases 
If cases have been scanned out, TOXICALL® applies a scan flag status which 
denotes that these cases have been scanned out.  If you wish to scan out these 
cases again, use the Supervisor menu on the Search window and select the 
cases you’d like to resend. Then use the Selected Cases/Reset Scanout Flag 
option. These cases will scan out when Autoupload sends the next batch. 
 

8.7 Reporting Errors from Archive Database 
Generally, when an error message is displayed when running a report against 
an archive database, it is necessary to copy system tables from the current 
network location to the archive database.  
 
 

8.8 MSIE or One of Its Components Not 
Found 

When starting TOXICALL® or installing, and you receive the error message 
‘MSIE or one of its components is not found,’ you will need to install Microsoft 
Internet Explorer 5.0 or higher onto the workstation.  
 
 

8.9 Autoupgrade Feature not Working 
Verify that  the Tox4Upgd.exe file is in the same location as is set in the 
Toxicall.ini file for the AutoUpgradeFile parameter. The path must be entered 
exactly or this feature will not work.   
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If the TOXICALL® installation process is asking the user to select a path for the 
install, check the AutoUpgradePrompt parameter in the TOXICALL® file.  It 
should be set to 0, if it should automatically upgrade without user input. 
 
 

8.10 Case is Slow to Open 
Check the settings in the Configuration window under the Tools menu. 
 

• Check that the Pre-load case and Keep Case tab in memory are set to No, 
as they are no longer supported and can cause some delay when opening 
a case. 

• Set Scale Case and Scale Case Summary to No.  If this is set to No, it will 
alter the way that the cases appear when opening on the local system.  
You may have to scroll to see all the windows.   

 
 

8.11 Components to Install Before Installing 
TOXICALL® 

Before the initial installation of TOXICALL® on a workstation, it is necessary to 
install several components. If these components are not installed or installed 
incorrectly, a Jet error message saying it cannot find a valid provider will be 
displayed when starting TOXICALL®.  
 
The required components are ADO 2.0 and ADO 2.6.  
 
Windows 95 workstations require DCOM 95, and Windows 98 workstations 
require DCOM 98.  DCOM is not needed for Windows 2000 or higher.  
 
These files are available on our website for download at:  
http://www.toxicall.com/download.htm  
 
 

8.12 Erratic Behavior in TOXICALL® 
If when working in TOXICALL®, you experience erratic behavior and the error 
message ‘do not continue to work’ is displayed, continuing to work may cause 
UNRECOVERABLE database corruption. Save your work, run a compact and 
repair on the network database if you are using Access, and restart TOXICALL®. 
If problems persist, inform your manager or call Technical Support. 
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8.13 Invalid Site Key 

When entering TOXICALL®, and the error message ‘Error -1 invalid site key’ is 
displayed, the workstation’s site key has expired and it is necessary to obtain a 
new site key.  
 
If you need only one or two licenses, you can call Toxicall Technical support and 
we can do this over the phone.  You will need to be in front of the computer that 
has expired in order for us to be helped. You will be asked for the computer 
name and the site code which you will see in the License window.  Technical 
Support will then issue a new license that you will type in the site key field. When 
done, hit the Update button, you should see a message that says that 
authorization has been approved.  Close the window and open TOXICALL®.  
 
If you need to renew your site license, the easiest method is to send the license 
file to Technical Support is by emailing the file to TOXICALL® Technical Support. 
You will need to locate the TX000nnn.ini file on your network server for 
TOXICALL®, where nnn is your center number. Attach to an email and send to 
support@toxicall.com.  Your file will be returned via email when it is ready.  
Please let us know if you would like assistance in installing the file, and we will be 
glad to help.  
 
It is a good idea to verify that the license was accepted properly by 
TOXICALL® after completing any of these methods. To check, simply close 
out of TOXICALL®.  Hold the Shift key down while you double click on the 
TOXICALL® icon on your desktop.  This should open the Configuration 
window, click on the License button.  The Days Remaining field should have 
changed.  If it did not, contact Toxicall Technical Support. 
 

8.14 Security Authorization Problem 
You will need to contact Toxicall Technical Support for a new site key. This  
message can be displayed for three different reasons. 
 

• Time Ran out on your TOXICALL® license agreement. 
• The workstation system date has been changed by more than 24 hours. 
• Running a disk defragmentation on the workstation hard drive has caused 

the Security DLL’s to be moved.  (When running a disk defragmentation, 
exclude the Local TOXICALL® folder and Windows system folders. 

 
 

8.15 Error 102/103 While Initializing 
This is an error from the licensing section of our software. The fix is: 
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• Go to the Windows or Winnt/system 32 directory and delete these files:  

ckldrv.sys, crypserv.exe and esnecil.ind.  You may have to stop the 
Crypserv service under Control Panel/Services first if you get an error that 
it is in use. 

• Find the setupex.exe file in the folder TOXICALL® is installed on that 
machine locally.  Double click it to run the file.  You will probably not see 
anything happen except a screen blink. 

• Try to open TOXICALL®. 
• If TOXICALL® isn’t working; reboot the machine, and when it comes back 

up run the setupex.exe file again.  Try to open TOXICALL®.  If this doesn’t 
work, call Toxicall Technical Support. 
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Note from the Author  

Dear TOXICALL® subscriber, Our team has been working on this 
document from many perspectives to try to bring the best documentation 
we can to you. We will be updating it as further enhancements are added 
to TOXICALL®.  

We respectfully understand that people learn from different techniques. To 
that end, we would enjoy hearing any feedback that you might have for 
consideration for a future version of this documentation.  

Thank you for your support,  

The TOXICALL® Team 

 
 


